Citavi helps you with all research tasks,
from searching for sources, to knowledge organization
and task planning, to creating a final publication.

– Getting Started

1

Setting Up

 Install After downloading, double-click Citavi5Setup.exe to
begin the installation. The Word Add-In and the Pickers (for
Firefox, Internet Explorer, Google Chrome, and Adobe Acrobat
and Adobe Reader) are automatically installed as well. Pickers
let you easily copy information from web and PDF documents.

 Functionality The number of references you can save in a
project depends on if you are using Citavi Free or a licensed
version. Citavi Free lets you save up to 100 references per
project, while a licensed version allows you to save up to
100,000 references per project.

 Obtaining a License You can purchase a license in our
online shop at www.citavi.com/shop. If your college or university offers a site license for Citavi, you can request your free license key at www.citavi.com/sitelicenses.

 Enter License Key You will find your license key in your
Citavi account, where you can copy it to the Clipboard. Then,
on the Citavi Welcome Screen, click License > Enter a license
key and continue through the license assistant.
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Adding and Navigating

Citavi consists of three workspaces: the Reference Editor, the
Knowledge Organizer, and the Task Planner.
Citavi offers 35 reference types to handle all your references
properly.

 Add a Reference Click Reference on the toolbar and select
the appropriate reference type.

 Hint: Reference types How references appear later on in
your bibliography depends on the reference type that’s used.
Which reference types are available? Click the reference types
that interest you to read descriptions of them. You can drag
the reference types that you use most often to the favorites on
the left.

 Enter Information As you enter information, click Quick
Help on the right to show helpful descriptions: they show you
how to best use Citavi. Some fields also have clickable labels
(if it’s blue, you can click it!). If you click Author, for example,
you get an author editor that can handle complex names:

Simple names can be entered directly (note the semicolon between authors): Miller, Peter M.; Smith, Jane
The Contents tab lets you save abstracts, tables of contents,
ratings
, and evaluations.

 Create a New Project On the welcome screen, click New
Project.
Give the project a unique name (for example, City Planning
Semester Project and click OK.
By default Citavi saves your projects in the folder
Documents\Citavi 5\Projects.

 Hint: Set up Backups Citavi automatically saves your
changes, so you don't have to remember to do so yourself.
Whenever you close a project, Citavi saves a backup of it under Documents\Citavi 5\Backup. The file name includes the
name of the project, the date, and the time the backup was
created. To increase the number of backups and change the
folder for backup copies, click Tools > Options > Folders.

 Hint: Retrieve by ISBN, DOI or PMID As long as you
have an active Internet connection, you can quickly add references with an ISBN number, DOI name, or PubMed ID.
Click
and enter the identifier, and then click Add.
Citavi downloads the bibliographic information for you.

 Special Case: Chapters in Edited Books, etc. First, add
the Edited Book (or Conference Proceedings, etc.) and enter
its information. Then click Add contribution. When you format
your publication, Citavi automatically pulls the right information from each reference.

If you need to restore a project from a backup, simply doubleclick the file.
Backup copies do not include files attached to your project. Be
sure to regularly backup the entire Documents\Citavi 5 folder
on an external drive.

 Navigate Click the arrows
references. Click Back
erences.

to browse through your
to return to previously viewed ref-

 Table View To see a handy overview of all your refer. You can choose the columns to display
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ences, click
and sort by.
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Searching for Sources

You can search over 4700 library catalogs, bibliographic databases and more right from within Citavi.

 Add a catalog Make sure you have an Internet connection,
click Online search, and then click Add database or catalog.

(Note: if you see “Available online: 0”, then the Internet connection is not working correctly.)
In the Name field, enter a key word, such as “London” to find
catalogs in London. This finds the London Public Library, the library of London Metropolitan University, and more. Select the
catalogs you want, and then click Add. Continue entering
search terms until you have added all the catalogs you want,
and then click Close to finish.
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Checking Information

When you add reference information using the Online Search,
the Pickers, or the ISBN, DOI, PMID feature, be sure to check
the information that was automatically added to your project.

 Check the Reference Type How your references appear in
your bibliography depends on the citation style and the reference type. After importing reference information, double-check
that the reference type is correct. To change a reference type,
click the blue label.

 Correcting Names Many databases export author names
in capital letters or in the wrong order. Right-click the name
and select the Edit option to make changes.

 Run a Search Select the catalogs you want to search. You
can select more than one catalog at a time. If you enter more
than one search word, Citavi will search for results containing
all of the search words. Pay attention to the Quick Help texts:
they give you tips for building your search. Click Search to run
the search.
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Using the Pickers

Pickers are extensions for Internet Explorer, Firefox, Google
Chrome, and Adobe Acrobat and Adobe Reader.
The Pickers make it easy to add Internet documents to your
project.

 Add a Webpage Make sure Citavi is running. To add a
webpage to Citavi, load the page, then right-click anywhere in
the browser window. Click Citavi Picker > Add webpage as reference. Citavi adds it to the current project as an Internet
Document and copies the bibliographic information, if available. (If the page doesn’t include it, you’ll have to enter it yourself.)

 Hint: Save Webpage as PDF Webpages often disappear
 Add Search Results Citavi presents the search results as
a list. If the search didn’t find what you want, try again with
different search terms. Then select the references you want to
add, and click Add to project.

 Cancel Selection The references you add to your project
are automatically applied as a selection (a subset of your references), so the others are hidden. This makes it easier to
work with just the new references, for example to review and
create tasks for them (see section 6). To see all references,
click Cancel selection in the status bar.

without warning. To make sure you always have a copy of the
text, you can save a PDF of the page. In the Preview, load the
page, and then click Save as PDF.

 Add a PDF Document The Picker for Adobe can not only
add PDF documents as references, but it can also save the PDF
files, too. Citavi adds a PDF as an Internet Document, extracts
the bibliographic information from the PDF, and then links the
PDF file as a Local file.

 Annotate Documents and Excerpt Quotations Read
webpages, e-books, and PDF files in the Preview. PDF documents can be annotated, and you can convert webpages and
e-books to PDFs for this purpose. Just click Save as PDF.
Excerpt text passages and images as quotations. Make sure to
enter the page number if it does not appear automatically.
Create tasks for individual passages, such as Examine and Assess or Discuss.

 Viewing Search Results Later On You can view a set of
search results imported at a given time by clicking the automatically added entry in the Import Groups column.

With a single mouse click, you can jump to annotations in a
PDF file from Citavi or the Word Add-In. Additional information
can be found at www.citavi.com/pdf-guide.

 Hint: Remove Line Breaks Text passages from PDFs often include hard line breaks. To get flowing text, double-click a
quotation, etc. in Citavi to open it, and then press
Ctrl+Shift+Space.
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Planning Tasks

Photocopy, Verify bibliographic information, and Read are just
a few of the tasks you can assign to a reference.

 Assign a Task to a Reference In the Reference Editor, on
the Tasks & Locations tab, click Task.

 Print a Task List To get an overview of all your tasks, in
the Task Planner, click Task list. A printable Task List is created.

 Hint: Create a Project Task In the Task Planner, you can
also create Project tasks, which do not apply to a specific reference. This is good for major deadlines, deliverable dates,
etc.
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Creating an Outline

It’s easy to create an outline for a paper with Citavi’s categories. You can assign categories to quotations and thoughts you
have collected to better structure your paper. This is very
helpful later on while writing.

 Create a Category System In the Knowledge Organizer,
click New category or New subcategory:
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Organizing Knowledge

You can save as many knowledge items — text and image
quotations, thoughts, and comments — in Citavi as you need.
The Knowledge Organizer helps you manage your collected
knowledge.

 Add Text Quotations You can save quotations from the
Preview as described in section 5. Of course, you can also add
quotations manually if you don’t have a source as a file on
your computer. Choose the right kind of quotation:
Direct quotation for a verbatim quotation, copied word-forword; Indirect quotation for the author’s thoughts in your own
words; Summary for a heavily condensed version in your own
words; Image or file quotation for images and audiovisual media; Comment for your opinions and notes about a statement
by the author.
In the Reference Editor, on the Quotation, Comments tab, click
New and then select the quotation type. Enter the Page range.
Click Core statement to enter a concise rewording of the main
idea of the quotation.

 Add Image Quotations Image and file quotations work
the same way as text quotations. You can enter a Description
and Caption as well. When you insert the image quotation into
your document, the caption will appear underneath it.

 Add a Thought You’ll find the light bulb

everywhere in
Citavi. Use it to jot down Thoughts at any time. If you have
handwritten notes, scan them in or photograph them with a
digital camera, and then save as an image thought.

 Create Associations Assign categories (see section 7),
Name the category, and continue adding new categories and
subcategories to match the structure of your paper.

keywords, and groups to your knowledge items. Use categories for the sections in your paper and keywords for creating
associations based on content. Groups can be used to organize
knowledge items in a way unrelated to their content.

 Hint: One Project, Multiple Publications Use the top

 Get an Overview In the category tree, click a category to

level of your category system for the names of individual publications. Enter the sections for each publication as subcategories.

 Assign Categories You can assign one or more categories

see the knowledge items that are assigned to it. You can compare what different authors have said by selecting multiple
quotations and looking at the content of the quotations in the
Preview.

to every reference, quotation, and thought in your project.
This lets you view only the items relevant to a particular section later on when you are writing your paper. Assign categories to references in the Reference Editor on the Context tab.
To assign categories to a quotation or idea, double-click it and
then enter the category in the corresponding field.

 Sort Knowledge Items You can arrange knowledge items

 Modify Your Category System It’s normal to need to re-

When you have a lot of knowledge items, you can use Subheadings to subdivide a category.

vise and change your outline as you progress. Just select a
category and use the controls to move it to its new place in
the system. (You can also drag a category to move it.)

in a logical order to structure the flow of ideas in your planned
paper and make it easier to write. Select a knowledge item
and use the arrows to move it up or down.

The changes automatically apply to all items in your project
assigned to the category.
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Writing with Word

With Citavi’s Add-In for Word you can enter references and
quotations into your document formatted exactly as your citation style prescribes. The bibliography is updated in real time
to match.
Do you work with Writer or a TeX editor? Please see our user
manual: www.citavi.com/manual5

Options include (Doe 2013), Doe (2013), Doe 2013, only Doe
or only 2013. To choose an alternate form, select the reference and click Insert advanced. Alternatively, you can rightclick an already inserted reference. In the shortcut menu you
can then select the form you want to use.

 Enter Page Numbers If you insert quotations from your

On the Citavi ribbon, click Citavi pane. Select a project to assign to the document.

project, Citavi will insert the page numbers automatically. Alternatively, you can insert a reference and then add the page
numbers. On the References tab, select a reference. Either
start typing the page number or click Insert advanced and enter the page numbers in the Page range field.

 Select a Citation Style To change citation styles, on the

Do not add prefixes or suffixes such as pp. 12-14. Your citation style will do this for you.

 Assign a Project to Your Document Open a file in Word.

Citavi ribbon, click the Citation style dropdown menu. Click
Add citation style. You can search for styles by name or citation system.
It’s important that you decide whether you want to use a footnote style or an in-text citation style before you start writing.
You can switch styles later on, but only within the same type
of style.

 Insert Categories and Knowledge Items If you used
categories to structure your knowledge items (as described in
section 7), insert your categories as headings. Right-click a
category on the References or Knowledge tab in Word. Click
Insert as heading to insert the category as a heading at the insertion point.

 Hint 1: Quickly Create a Rough Draft Instead of inserting individual chapters, you can use the option Insert categories and knowledge items to quickly create a rough draft of
your paper. This lets you draw on the work you’ve done in
Citavi when you begin writing your paper in Word.

 Hint 2: Insert an Outline from Citavi You’d rather only
insert your outline and add quotations yourself while you
write? Right-click a category, point to Insert categories and
knowledge items, and then clear the Include knowledge items
checkbox. Your category system will then be inserted using
Word headings. On the Chapter tab, you can view and insert
the references and knowledge items for the chapter in which
the cursor is located.

 Insert References
On the References or
Chapters tab, select the
reference you want to
insert. Either click Insert or double-click the
reference.

 Insert Quotations
or Thoughts On the
Knowledge or Chapters
tab, select the quotation or thought you
want to insert. Either
click Insert or doubleclick the knowledge
item.

 Change the Form
For in-text citation
styles using the author
and year format, you
can easily change the
format of the citation.
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 Entering Multiple Citations First, insert the first reference into your document. Then, place the insertion point in the
reference you just inserted. Insert additional references. Depending on the citation style, you will end up with a citation
that looks like (Doe 2013, Miller 2013, and Smith 2010) or
[14-16].
Editing Multiple Citations Select the multiple citation in the text.
Click the Citations tab.
Near the bottom of the
pane you can delete unwanted references by clicking the
or
change the order of citations with the arrows.
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Project Bibliographies

Sometimes all you need is a simple list of references.

 Print Project Bibliographies On the File menu point to
Print or save project bibliography and then select Print in current citation style. This will generate a list of the references
currently displayed in the current citation style.

 Select References If you want a list of all the references
in your project, continue to step . If you only want one reference or a small number of references to appear in the bibliography, select them using the Ctrl key. Then right-click one of
the references and select Apply as selection. You can use the
Filter
or Search features to create a larger selection.

 Change the Sort Order As a default, Citavi sorts all references alphabetically and then by year. To change the sort order, right-click the list of references. Click Sort and then set
the sort order the way you want it.

 Change the Citation Style On the Citation menu, click Citation style, and then click Browse citation styles. After that
click Find and add style.

 Choose what Your Bibliography Should Include To
create a list of references grouped by specific criteria, click
Print grouped or Save grouped. To create a list of references
with quotations, abstracts, evaluations, etc., click Print annotated or Save annotated.

?

More Information and Help

Download:
Account:
Manual:
Support:

www.citavi.com/download
citaviweb.citavi.com/account
www.citavi.com/manual5
www.citavi.com/help

